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1. Der Astrospektroskopiekurs und die Schülersternwarte am Carl-

Fuhlrott-Gymnasiums 
 

Als nahezu unbeschriebenes Blatt in der Astronomie und gänzlich unerfahren in der 

Astrospektroskopie ging ich erwartungsvoll vom 05 bis zum 09 Oktober zum 

Astrospektroskopiekurs im Carl-Fuhlrott-Gymnasium, zu dem ich dankenswerterweise 

noch sehr kurzfristig einen Platz erhalten habe. 

Die Teilnehmer des Kurses, bestehend aus Schülern, Studenten und Sternfreunden 

aus verschiedenen Berufssparten bildeten eine bunte, bereichernde Mischung und von 

unterschiedlichsten Ausgangspunkten wurde das Ziel angegangen, mehr über 

Sternspektroskopie zu lernen. Dem erreichen eben dieses Zieles wurde man sich sehr 

schnell sicher, da sich die Begeisterung der Dozenten für das eigene Thema bei der 

Vermittlung der Theorie zum Verständnis der Sternspektroskopie und der Auswertung 

der Spektren, unterstützt von fantastischen didaktischen Mitteln, wiederspiegelte.  

Geradezu sprachlos und zutiefst beeindruckt war ich von den sechs 

Beobachtungsstationen und der Hütte mit einer weiteren größeren 

Beobachtungsstation auf dem Dach der Schule. Allen Widrigkeiten zum Trotz wurde 

hier mit viel Arbeit, Engagement, Ehrgeiz und Freude eine Sternwarte geschaffen, die 

so, sehr wahrscheinlich einzigartig in der Welt ist. Unterbringung, Transport und 

Aufbau der Teleskope und deren zahlreiches Zubehör sowie deren Nutzung, sei es an 

der Station selbst, oder sogar windgeschützt und Computergesteuert aus einem 

anderen Schulraum, sind bis ins Detail durchdacht. 

Leider war es uns in der ganzen Woche aufgrund des schlechten Wetters nicht 

vergönnt in den Abend- oder Nachtstunden einen tiefen Blick in den Nachthimmel zu 

werfen, sodass dieser praktische Teil entfiel. Dennoch möchte ich in diesem Bericht 

das umfangreiche Wissen aus dem Kurs festhalten, um es zu bündeln und selbst 

einmal verwenden zu können. Hierzu gebe ich zuerst eine Einführung in die Theorie 

der Astrospektroskopie und im Anschluss behandel ich die Bearbeitung und 

Auswertung von Spektren exemplarisch am Beispiel eines Sonnenspektrums. 

 

 

 

 

 

 

 



 

5 

2. Astrospektroskopie – Die Theorie 

2.1 Einführung in die Spektroskopie 

2.1.1 Für was wird die Astrospektroskopie benötigt? 
 

Schon seit jeher gelten Sterne für Forscher und Träumer als faszinierende Objekte für 

Mysterien, Abenteuer und eine strahlende Zukunft. Und seit Beginn der Spektroskopie 

ist es möglich, die Rätsel eines Sterns zu entschlüsseln, ohne ihn bereisen zu müssen. 

Vorher war lediglich der Ort des Sterns bekannt. 

Mithilfe eines Spektroskops kann man heute durch die reine Lichtinformation über 

abertausende Kilometer hinweg Aussagen über Temperatur, Druck, Dichte und 

Elementarzusammensetzung der Sternoberfläche und –umgebung geben. Sogar 

Aussagen über Sternbegleiter oder Exoplaneten sind möglich, wenn diese für die 

Spektroskopie günstig vor dem Stern stehen. Zudem kann man die Geschwindigkeit 

und Rotationsgeschwindigkeit eines Sterns berechnen, indem man die Neigung und 

Verschiebung der Spektrallinien berücksichtigt. 

Aus der Ferne betrachtet, sogar vom heimischen Garten oder Dach aus, kann man 

also über das Sternspektrum die Essenz eines Sterns entschlüsseln. 

2.1.2 Was ist Licht? – Zerlegung und das elektromagnetische Spektrum 
 

Heute sprechen wir von vielen Arten von Licht. „Gammalicht“, „Röntgenlicht“, UV-

Licht“, Infrarotlicht“ und „Radiolicht“ könnte man als unsichtbares Licht bezeichnen, da 

wir Menschen es nicht direkt „sehen“ können. So auch nicht Isaac Newton, als er 1666 

herausfand, dass weißes sichtbares Licht aus mehreren Farben zusammengesetzt ist.  

Diese Arten von Licht, sichtbares und unsichtbares, sind elektromagnetische 

Phänomene und werden daher unter dem Begriff „Elektromagnetische Strahlung“ 

zusammengefasst. Was ist mit dem „Welle-Teilchen-Dualismus“, werden sich hier 

sicherlich einige fragen. Die Modellvorstellung Newtons (1642-1727) von Licht als 

Partikel und die Vorstellung Huygens (1629-1695) von Licht als Welle werden zwar 

noch heute genutzt, aber sind doch widerlegbar. Aus Youngs Doppelspaltexperiment 

(1802) und Einsteins Deutung des Photoeffekts (1905) muss man in Anbetracht dieser 

Ausschlusskriterien davon ausgehen, dass Licht im Sinne der klassischen Physik 

weder Welle noch Teilchen ist. Im Zuge Einsteins Deutung sprach er auch von einem 

„Lichtquant“ oder Photon und dadurch wurde die Quantenphysik geboren. 
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Bei der Sternspektroskopie erhalten wir die Spektren dieser elektromagnetischen 

Wellen. Die Wellen sind charakterisiert durch ihre Frequenz f und die Wellenlänge λ. 

Es gilt der Zusammenhang, je größer die Wellenlänge bzw. je kleiner die Frequenz, 

desto kleiner ihre Energie. Dies ist den folgenden Formeln sehr schön zu entnehmen, 

denn es gilt: 

𝐸 = ℎ ∗ 𝑓 = ℎ ∗
𝑐

𝜆
 

Mit E: Energie; h: Plancksches Wirkungsquantum; c: Lichtgeschwindigkeit;  

𝜆: Wellenlänge 

 

Die eben genannten, für das menschliche Auge sichtbaren und unsichtbaren Arten des 

Lichts, unterscheiden sich in ihren Wellenlängen. Während die Radiostrahlung 

Wellenlängen von Millimetern bis Kilometern besitzt, beträgt die Länge der sichtbaren 

(„optischen“) Licht-„wellen“ nur einige hundert Millionstel Millimeter. Man misst sie 

daher in Nanometer. Die verschiedenen Farben des sichtbaren Lichts werden durch 

die verschiedenen Wellenlängen charakterisiert. Abbildung 1 zeigt anschaulich die 

Bandbreite des elektromagnetischen Spektrums und die Wellenlängenbereiche des 

sichtbaren Lichts. 

 

Abbildung 1: Das elektromagnetische Spektrum & Wellenlängenbereich für sichtbares Licht 

Für eine genauere Untersuchung des Sternlichts ist es zunächst notwendig, das 

ankommende Licht in seine Bestandteile zu zerlegen. 
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Dazu kann entweder ein Prisma oder ein Spalt eingesetzt werden. Wobei Ersteres mit 

dem Phänomen der Lichtbrechung mittels eines dichteren Mediums1(Abbildung 2), 

Letzteres mit dem der Lichtbeugung arbeitet. Bei unserer Sternspektroskopie mit dem 

Dados-Spektrograph wird auf die Lichtbeugung am Spalt zurückgegriffen. 

 

Abbildung 2: Prismenspektrograph 

Um die Lichtzerlegung am Spalt zu verstehen, betrachten wir zunächst einen 

Doppelspalt wie in folgender Abbildung: 

 

Abbildung 3:Lichtbeugung am Doppelspalt - konstruktive & destruktive Interferenz 

                                                           
1 In der Astronomie verwendet man einen Objektivprismenspektrograph, bei dem direkt hinter dem Prisma 
eine Kamera angebracht ist, die das Licht verschiedener Richtung auf verschiedene Stellen des 
photographischen Films abbildet. 
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In eine undurchsichtige Platte werden zwei feine Schlitze geritzt und diese wird mit 

einfarbigem Licht bestrahlt. Auf der anderen Seite wirkt jeder der beiden Spalte als 

Lichtquelle die Lichtwellen aussendet. Treffen diese Lichtwellen im selben Takt auf der 

Wand auf (siehe Abb. 3 im Punkt 0), interferieren sie konstruktiv; d. h. sie überlagern 

und verstärken sich. Das Ergebnis ist eine helle, einfarbige Stelle auf der Wand.  

Beträgt der Wegunterschied zu den beiden Spalten gerade eine halbe Wellenlänge 

(also wandert man von der Stelle 0 ein wenig nach oben oder unten), kommen die 

Lichtwellen im Gegentakt an und interferieren destruktiv; d. h. sie löschen sich 

gegenseitig aus. Das Ergebnis ist eine dunkle Stelle an der Wand, obwohl sie von 

beiden Spalten beleuchtet wird. 

Jedes Mal, wenn der Wegunterschied ein ganzes Vielfaches der Wellenlänge 𝜆 

beträgt, finden wir einen hellen Interferenzstreifen und dazwischen liegen dunkle 

Streifen. Also: 

∆𝑠 = 𝑛 ∗ 𝜆 

Mit n ∈ 𝑁0, ∆𝑠: Gangunterschied, 𝜆: Wellenlänge. 

Weiterführende Informationen zur Natur des Lichts, der Zerlegung an Spalt und Gittern 

oder Prismen mit entsprechenden Erklärungen geben sehr anschaulich die Seiten der 

LEIFI-Physik-Webseite [6], die Internetseite der Uni Mainz mit einem sehr schönen 

Versuch zum Doppelspalt [5] oder Standardwerke der Physik wie  

Gerthsen [3] oder Tipler [4]. 

 

 

 

2.1.3 Die verschiedenen Typen von Spektren 

 

Je nach Art der Lichtquelle können drei unterschiedliche Arten von Spektren 

beobachtet werden, welche alle in der Astronomie vorkommen und die ich hier rein 

phänomenologisch vorstellen werde. 

a) Rein kontinuierliche Spektren  

Um zunächst den Bezug zur Astronomie zu geben, treten diese (nahezu) rein 

kontinuierliche2 Spektren im sichtbaren Bereich bei sehr heißen Sternen auf oder bei 

sehr kühlen (Infrarot-) Objekten, die im optischen Bereich im wesentlichen thermisch 

strahlen. 

Das rein kontinuierliche Spektrum umfasst einen Wellenlängenbereich vom 

langwelligen Rot bis zum kurzwelligen Ultraviolett; und kann durch glühende Körper 

oder durch glühende Flüssigkeiten oder Gase unter hohem Druck erzeugt werden. [1] 

                                                           
2 „kontinuierlich“ bezieht sich hier auf den betrachteten Lichtbereich 
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Abbildung 4: Rein kontinuierliches Spektrum [2] 

b) Reine Emissionslinien Spektren 

Reine Emissionslinien Spektren können bei Gasnebeln beobachtet werden, die von 

benachbarten Sternen durch UV-Strahlung zum Leuchten angeregt werden. Auch im 

Spektrum der Sonnenchromosphäre, die durch das Strahlungsfeld der Photosphäre 

angeregt wird, treten diese auf. 

Erzeugt durch ein heißes Gas bei geringem Druck, zeigt dieses Spektrum einzelne 

helle Linien, die in ihrer Kombination und Anordnung jeweils charakteristisch für ein 

Element oder Molekül sind. [1] 

 

Abbildung 5: Reines Emissionslinien Spektrum [2] 

c) Absorptionslinien Spektren 

Das Absorptionslinien Spektrum ist das am häufigsten auftretende Spektrum bei der 

Spektroskopie von Sternen. Auch unsere Sonne zeigt ein ausgeprägtes 

Absorptionsspektrum. 

Wo beim Emissionslinien Spektrum die hellen Linien beim Durchscheinen eines 

heißen Gases erscheinen, beobachtet man beim Absorptionslinien Spektrum beim 

Durchscheinen eines kühlen Gases mit kontinuierlichem Licht an diesen Stellen dunkle 

Linien. Offensichtlich „fehlt“ Licht an diesen Stellen. [1] 
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Abbildung 6: Absorptionslinien Spektrum [2] 

Würde man das Emissionslinien und das Absorptions Spektrum addieren, ergäbe dies 

praktisch wieder das kontinuierliche Spektrum.  

Durch die Spektren kann man in gewisser Weise den „kosmischen“ Fingerabdruck 

eines Sterns und damit Auskunft über die Kombination der Elemente, aus denen er 

besteht, erhalten. Um zu klären wie man von den gegebenen Linienmustern auf 

Elemente schließen kann, muss man vom ganz Großem zum ganz Kleinen und sich 

die Theorie der Teilchenebene und der Erzeugung elektromagnetischer Strahlung 

anschauen. 

2.1.4 Wie kommen die verschiedenen Sternspektren zustande? – Ursprung 

und Natur des Lichts 
 

Licht – genauer gesagt jede sichtbare und unsichtbare elektromagnetische Strahlung 

hat ihren Ursprung in den Energieänderungen von Elektronen. Wird der 

Energiezustand eines Elektrons durch irgendein Ereignis verkleinert, so wird die 

Energiedifferenz in Form von Licht abgegeben. [1] 

Das Bohrsche Atommodell 

Atome bestehen bei diesem Modell aus einem schweren, positiv geladenen Atomkern 

und leichten, negativ geladenen Elektronen, die den Kern auf geschlossenen Bahnen 

strahlungsfrei umkreisen (vgl. [6], S. 3). Dabei sind die Elektronenbahnen erlaubt, für 

die gilt, der Bahndrehimpuls des betrachteten Elektrons entspricht dem ganzzahligen 

Vielfachen einer Grundeinheit des Drehimpulses. 

v =
𝑛 ∗ ℎ

2𝜋 ∗ 𝑟 ∗ 𝑚
 

mit m: Masse des Elektrons; v: Geschwindigkeit des Elektrons; r: Kreisbewegung;  

n: Quantenzahl (n=1,2,3…);  

h: Planksches Wirkungsquantum (6,626 ∗ 10−32𝑘𝑔 𝑚2𝑠−1) 
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Je nachdem, auf welcher Bahn sich ein Elektron befindet, besitzt es ein 

unterschiedliches Energieniveau und strebt danach diese Energie abzugeben um auf 

eine Bahn in Atomkernnähe zu gelangen. Ist das Elektron auf der niedrigsten Schale 

bzw. Bahn, befindet sich das Atom im Grundzustand. 

Wie bereits erwähnt, gibt das Atom immer dann elektromagnetische Strahlung ab 

(oder nimmt sie auf), wenn sich der Energiezustand eines Elektrons ändert, es also 

seine Kreisbahn verlässt. Um einen angeregten Zustand, also ein höheres 

Energieniveau zu erreichen, muss ein Elektron genau diese Energie aufnehmen, die 

es zum Sprung auf die nächste Stufe braucht. Der angeregte Zustand des Elektrons 

ist aber nur von sehr geringer Dauer, da es wie bereits festgestellt, immer ein möglichst 

geringes Energieniveau einnehmen will. Beim „Herunterfallen“ auf das niedrigere 

Niveau entsteht die Energiedifferenz 

∆𝐸 = 𝐸𝑛 − 𝐸𝑚 

mit 𝐸𝑛: höhere Energie; 𝐸𝑚: niedrigere Energie 

Diese Energie können wir beispielsweise als Licht wahrnehmen.3 

Erklärung anhand des Wasserstoffatoms 

Wir betrachten nun einen einfachen Atomkern, den des Wasserstoffatoms, der sich 

besonders für schulische Zwecke zur Erklärung eignet, da dieser bloß aus einem 

Neutron und einem Photon im Kern besteht sowie einem Elektron auf einer kernnahen 

Schale. 

Durch die soeben festgestellte Energiedifferenz ∆𝐸 wollen wir nun die Wellenlänge 𝜆 

der abgestrahlten Lichtwelle berechnen: 

𝜆 =
1,98 ∗ 10−25

∆𝐸
𝐽 ∗ 𝑚 

Da wir bereits festgestellt haben, dass bei großer Energiedifferenz kurzwelliges Licht 

entsteht, wissen wir somit auch das die Wellenlänge 𝜆 antiproportional zum 

Energieverlust der Elektronen ist. Explizit für das Wasserstoffatom lassen sich über 

folgende Formel die Energien der einzelnen Energieniveaus berechnen: 

𝐸𝑛 =
−2,17 ∗ 10−18

𝑛2
𝐽 

Dies ergibt für die Wellenlänge des Lichts, das bei Übergängen des Elektrons von dem 

n.ten zum m.ten Niveau im Wasserstoffatom abgestrahlt wird: (vgl. [1]) 

𝜆 =
9,12 ∗ 10−8

1
𝑚2 −

1
𝑛2

𝑚 =
91,2

1
𝑚2 −

1
𝑛2

𝑛𝑚 

 

                                                           
3 Je größer der Energieverlust, desto blauer (kurzwelliger) das Licht. 
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Erweitern wir dieses reduzierte Modell des Wasserstoffatoms um eine ganze Reihe 

von Schalen mit größeren Radien und definierten Abständen, erhalten wir eine 

Darstellung wie sie auf Abbildung 7 zu sehen ist. 

Wird die Energiemenge so groß, dass dem Elektron ermöglicht wird die Bahnen und 

damit den Kern zu verlassen, bildet sich ein Proton/Wasserstoffkation H+. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Je nach Stärke der Energiezugabe kann das Elektron auf unterschiedliche Bahnen 

angehoben werden und dann auch wieder auf unterschiedlichen Bahnen landen. Bei 

genauerer Betrachtung entstehen Muster von Übergängen die von ihren Entdeckern 

benannt, in Serien zusammengefasst worden sind. 

∙∙∙  Hε Hδ Hγ     Hβ Hα 

\  | | / | | 

∙∙∙     n=7 n=6  n=5  n=4               n=3 

Ultraviolett   V i o l e t t Blau Rot 

 Abbildung 7: Schematische Darstellung des Wasserstoffspektrums [2] 
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Man nennt alle Übergänge zu… 

… m = 1 (Grundzustand) „Lymanserie“. 

… m = 2 „Balmerserie“. 

… m = 3 „Paschenserie“. 

… m = 4 „Bracketserie“. 

… m = 5 „Pfundserie“. 

Das Elektron wird solange Elektronenübergänge vollziehen, bis es den Grundzustand 

erreicht. 

Anhand der Abbildung 7 ist gut zu erkennen, dass die Linien im violetten Teil des 

Spektrums dichter aufeinander folgen, weil die erlaubten Energieniveaus im Atom mit 

zunehmendem Abstand vom Kern immer enger beieinander liegen (vgl. [1]). 

Zur Orientierung wird die Balmerserie genutzt, da nur sie im sichtbaren Bereich des 

Spektrums liegt. Die Elektronenübergänge von denen hier die Rede ist, werden 

„gebunden – gebunden- Übergänge“ genannt und finden demnach nur auf den 

Atomschalen statt. 

 n 𝜆 [nm] 

H𝛼 3 656,3 

H𝛽 4 486,1 

H𝛾 5 434,0 

H𝛿 6 410,2 

H𝜖 7 397,0 

H8 8 388,0 
Tabelle 1: Balmerserie des 
Wasserstoffspektrums 

 

 

Weitere mögliche Übergänge ist der auf 

Abbildung 9 dargestellte „frei – frei Übergang“, bei dem ein Elektron nah an einem Ion 

vorbeifliegt, ohne eingefangen zu werden, und der auf Abbildung 10 dargestellte „frei 

– gebunden – Übergang“, bei dem ein positiv geladenes Ion freie Elektronen auffängt. 

Abbildung 8: gebunden - gebunden – Übergänge [2] 

Abbildung 10: frei - gebunden – Übergänge [2] 

Abbildung 9: frei - frei – Übergänge [2] 
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Bei diesen Übergängen wird Energie von unterschiedlichsten Beträgen freigesetzt, 

welches zu Licht verschiedenster Wellenlängen führt. 

Wie Eingangs schon beschrieben ist Wasserstoff aufgrund seiner eher simplen 

Zusammensetzung als beschreibendes Grundlagenmodell sehr gut geeignet. 

Allerdings kommen in der Spektroskopie noch weitaus mehr und vor allem 

vielschichtige Elemente mit mehr Energiestufen vor die dadurch deutlich komplexere 

Linien aufweisen. Jedoch bleibt das beschriebene Grundprinzip gleich. 

Um der Vollständigkeit halber darauf einzugehen, muss erwähnt werden, dass die 

Spektroskopie mit Molekülen aufgrund ihrer Atomverknüpfung, Bewegung & Rotation 

weitaus komplexer ist. Es entstehen sehr viele nah bei einander liegende 

Energieniveaus, die breite Banden im Spektrum bilden und „verschmiert“ aussehen. 

 

2.2 Klassifikation von Sternspektren und das Hertzsprung-Russell-Diagramm 

2.2.1 Harvard Klassifikation 
 

„Oh, be a fine girl – kiss me!“ [1 bzw. 7] 

Dieser einprägsame Merksatz, bei dem man das “girl” auch durch „guy“ ersetzen kann, 

entstand durch die Einteilung von Sternen nach ihrer Temperatur in Spektralklassen. 

Die amerikanische Astronomin Annie Jump Cannon erfasste und klassifizierte mit 

einer eigens ermittelten Klassifikation4 in mühevoller Arbeit über 250.000 Sterne, und 

veröffentlichte diese Arbeit im „Henry Draper Catalogue“. 

„O B A F G K M“ ist die heutige Harvard-Klassifikation der Sternspektren, die in 

folgender Tabelle erläutert wird: 

Spektral- 
typ 

Temperatur- 
Bereich [°K] 

Spektrum 

O 50.000 – 25.000 Intensives kontinuierliches Spektrum mit Absorptionslinien des 
einfach ionisierten Heliums, andere Elemente min. zweifach 
ionisiert, wenige Fraunhofer-Linien, schwache Balmerlinien 
(Wasserstoff) 

B 25.000 – 10.000 Schwache Balmerlinien (Wasserstoff) und Linien neutralen Heliums 

A 10.000 – 7.500 Maximale  Stärke  der  Balmerlinien,  keine  Heliumlinien,  Eisen  (Fe+) 
und  Kalzium  (Ca+)  -  Linien,  die  K-Linie  des  Kalziums  ist  schwach 
sichtbar 

F 7.500 – 6.000 Dominierende Balmerlinien  (Wasserstoff, s c h w ä c h e r  a l s  b e i  
G), 
starke H- und K-Linien des ionisierten Kalziums; Metalllinien G 6.000 – 5.000 Sonnenähnliches Spektrum, H- und K-Linien des ionisierten Kalziums 
dominieren, Balmerlinien schwach  sichtbar, mehrere 
Metalllinien (intensive Eisenlinien) 

K 5.000 – 3.500 Intensive Linien von Metallen, insbesondere Eisen, H- und K-Linien, 
und das intensive G-Band von Kohlenwasserstoffmolekülen CH 

                                                           
4 Basierend auf den Vorarbeiten von Williamina Fleming (1857-1911) und Antonia Mary (1866-1952) [1] 
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M ≤ 3.500 Starke breite Titanoxidbanden TiO, viele Linien neutraler Metalle, 
Linien des Eisens und Calciums  (423 nm), und das G-Band von 
Kohlenwasserstoffmolekülen CH 

Tabelle 2: Harvard-Klassifikation der Sternspektren 

Wie man der Tabelle entnehmen kann, geben die Spektralklassen in ihrer Anordnung 

Auskunft über die Oberflächentemperatur von Sternen. Zudem wird jede 

Spektralklasse noch einmal in 10 Gruppen unterteilt (auch wenn bis heute noch nicht 

alle diese Gruppen „genutzt“ wurden), die mit einer Zahl von 0 – 9 bezeichnet werden. 

Diese Unterklassen unterscheiden sich nicht in Temperatur oder 

Elementenkombination, sondern beispielsweise in Masse oder Radius. [1] 

2.2.2 Die Morgan-Keenan-Klassifikation 
Die Wissenschaftler Morgan und Keenan arbeiteten um 1943 am Harvard-

Obervatorium an einer zusätzlichen Klassifikation, die die bisherigen Spektralklassen 

um sechs weitere Klassen, nach der Breite ihrer Spektrallinien, erweitern sollte. Dabei 

beobachteten sie eine Leuchtkraftsequenz, weshalb man diese Klassen heute als 

Leuchtkraftklassen bezeichnet. 

 

Abbildung 11: Die heutige MK-Leuchtkraftklassifikation 

In der Sternspektroskopie verwendet man heutzutage eine 2-dimensionale 

Klassifikation von Sternspektren in der ein Großbuchstabe für den Spektraltyp nach 

Harvard, eine Zahl zur Beschreibung der Gruppe seiner Klasse und eine römische 

Ziffer zur Leuchtkraftklassenbezeichnung. Dies sieht dann so aus: 

αLyr (Wega): A0V 

Im Beispiel wäre dies der Stern Wega mit Typ A (nah an 10.000 °K, da Gruppe 0) der 

ein sonnenähnlicher Stern (V) ist. 
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2.2.3 Das Hertzsprung-Russell-Diagramm 
Das Hertzsprung-Russell-Diagramm (HRD) wird auch als „Diamant der Astrophysik“ 

bezeichnet und zeigt lauter einzelne Sterne in ihrem jeweiligen Lebensstadium. 

 

Abbildung 12:Hertzsprung-Russell-Diagramm [2] 

Das in Abbildung 12 gezeigte Bild erhält man, wenn man die Leuchtkraftklasse eines 

Sterns gegen dessen Spektraltypen aufträgt und diese Informationen von möglichst 

vielen Sternen in einem Diagramm abbildet. 

Es wurde beim hinzufügen von mehr und mehr Sterndaten schnell klar, dass das zu 

beobachtende Muster kein zufälliges ist. 

Wie eingangs beschrieben, zeigt das HRD das Stadium eines jeden Sterns. In der 

Summe bilden diese Sterne jedoch einen Lebens- bzw. Entwicklungsweg ab. Dadurch 

ist es möglich, Vergangenheit und Zukunft eines Sterns zu bestimmen. Und das bloß 

anhand seiner Leuchtkraftklasse und seines Spektraltyps. Heute weiß man, dass der 

Entwicklungsweg eines Sterns allein von seiner Masse bei seiner Entstehung abhängt 

(vgl. [1]). 
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Um diesen Entwicklungsweg zu verdeutlichen, stelle ich hier exemplarisch den 

Lebensweg unserer Sonne von der Entstehung bis zum Tod dar: 

 

Abbildung 13: Lebensweg unserer Sonne im HRD [2] 

 

Dankenswerterweise ist unsere Sonne sehr stabil und 

befindet sich bereits seit Urzeiten im „Erwachsenenalter“ und wird dies auch noch 

lange tun. 

 

 

 

 

 

 

 

 

 

 

 

 

Linie bis A:    

Geburtslinie (sog.Hayashipfad)  

Linie bis B:   

Hauptreihenstadium  

Linie bis C:    

Erschöpfung des H-Brennens, 

Kollaps  

Linie bis D:    

Aufblähung zum Riesen  

Linie bis E:    

Heliumbrennen führt zur weiteren 

Aufblähung  

Linie nach E:    

Erschöpfung des Heliums in der 

Mitte, Kollaps, Beginn des 

Schalenbrennens, Abwurf der 

Hülle, Kollaps zum Weißen 

Zwerg 
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3. Die Praxis – Aufnahme und Auswertung von Sternspektren 
Wie zu Beginn dieses Berichts bereits erwähnt, war uns das Wetter in dieser Woche 

nicht gewogen und so war es nicht möglich Messungen an der Sternwarte 

durchzuführen. Jedoch wurden wir mit dem Umgang der Gerätschaften unterwiesen, 

sodass es uns (theoretisch) möglich gewesen wäre Messungen durchzuführen. 

Jedoch kann man bei jedem Wetter das Sonnenspektrum aufnehmen und auswerten, 

welches wir auch im Übungsraum getan haben, und, worauf ich mich auf den 

kommenden Seiten beziehen werde. 

3.1 Aufbau und der DADOS-Spektrograph 
In der Abbildung 14 ist der Aufbau mit Teleskop und DADOS-Spektrograph zu 

erkennen. In Abbildung 15 derselbe Aufbau mit aufgesteckter CCD-Kamera. 

Zur Kalibrierung ist auf das Pentax 75 Teleskop eine Neon-Lampe aufgesteckt (unten 

am Bild). Auf diesem Bild fehlt noch die Canon EOS 450D die an Würfel 2 des DADOS 

gesteckt wird. 

 

Abbildung 14: Aufbau mit Neon-Kalibrationslampe 

Abbildung 15: Aufbau mit aufgesteckter CCD-Kamera 
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Um zu verdeutlichen, wie die in den folgenden Abschnitten gezeigten Bilder zustande 

kommen, erkläre ich mithilfe der Abbildung 16 kurz den Strahlengang im 

Spektrographen. 

Das mit dem Pentax 75 Teleskop eingefangene Licht fällt in den ersten Würfel, der 

zusätzlich zur Parallelisierung des Strahls durch den Kollimator auch die Beobachtung 

eines Objekts durch einen Spiegel und einen Spalt erlaubt, welche durch einen an das 

Nachführokular angeschlossenen Guider möglich ist. Im zweiten Würfel wird der 

Lichtstrahl am Gitter zerlegt und darauf am Objektiv erneut gebündelt um von der 

Kamera aufgenommen zu werden. Die eingesetzte DSLR-Kamera wurde modifiziert, 

da die Standardfilter einige Bereiche, die für die Spektroskopie interessant sind, zu 

unsensibel werden lassen. 

Zusätzlich haben wir erfahren, dass große Bastler es bereits geschafft haben, durch 

Kühlung und umgebaute handelsübliche Kameras, Spektrenbreiten aufzunehmen die 

mit denen von Profigeräten locker mithalten zu können. 

 

Abbildung 16: Strahlengang im Spektrographen [8] 

Nachführokular (Anschluss Guider) 

Anschluss Teleskop 
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3.2 Die Sonne G2V 
Unsere Sonne dominiert mit ihrer enormen Masse das Sonnensystem und lässt acht 

Planeten geduldig um sich kreisen. Der Strahlung der Sonne ist es zu verdanken, dass 

zumindest auf einem dieser Planeten, unserer Erde, Leben entstanden ist. Das 

charakteristische Sonnenspektrum mit seinen dunklen Fraunhoferlinien (siehe 2.1.2 f) 

kann man zu jeder Witterung aufnehmen, wodurch es sich für Lehrzwecke sehr gut 

eignet. 

3.3 Spektrenbearbeitung und Auswertung 
Bevor ich mit der Darstellung der einzelnen Arbeitsschritte beginne, möchte ich ein 

grundsätzliches Problem ansprechen, dass auch einigen Teilnehmern des Kurses 

unangenehm aufgefallen ist. 

Sämtliche Programme die zur Aufnahme und Bearbeitung der Spektren innerhalb des 

Kurses auf den Schulrechnern genutzt werden, funktionieren bis auf einige 

Ausnahmen, die das jeweilige Programm selbst betrifft, tadellos. Nimmt man jedoch 

seinen eigenen Laptop oder Computer zuhause, der mit aller Voraussicht mit einem 

moderneren Betriebssystem als Windows XP ausgerüstet ist, stößt man auf Probleme. 

So funktionierten auch bei mir viele der Programme, die wir erhalten haben, nicht. 

Besonders Visual Spec macht auf neuen Rechnern Probleme.  

Um derartige Schwierigkeiten direkt aus dem Wege zu gehen, lege ich daher jedem 

Nutzer nahe, die Internetseiten des jeweiligen Herstellers (sind in der Quellenangabe 

zu finden) aufzusuchen und die neuesten Versionen der jeweiligen Programme, soweit 

vorhanden, herunterzuladen. Bei Visual Spec ist es zudem nötig, nach der Installation 

des eigentlichen Programms die .exe Datei durch eine andere zu ersetzen5. Zudem 

muss man alle Programme als Admin starten (Rechtsklick auf die auszuführende Datei 

→ Als Administrator ausführen). Sollten immer noch Probleme auftreten könnte der 

Kompatibilitätsmodus Abhilfe schaffen (Rechtsklick auf die auszuführende Datei → 

Eigenschaften → Reiter „Kompatibilität“ → Haken bei „Programm im 

Kompatibilitätsmodus ausführen für:“ → Windows XP auswählen). 

Die für die Bearbeitung benutzen Programme sind: 

(Alle Programme ohne Versionsangaben) 

Fitswork [9] 

Maxim DL [10] 

Visual Spec [11] 

Photoshop (ältere Versionen sind kostenlos erhältlich, so z. B. [12]) 

Screen-Capture-Programm, beliebig z.B. [13] 

 

 

 

                                                           
5 Mehr dazu auf http://www.astrosurf.com/vdesnoux/download1.html 
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Vorbereiten der Bilder 

Wir haben aus dem Seminarraum heraus mehrere Bilder bei diffusem Licht mit der 

Kamera SBIG STF-8300M geschossen. Wir wählten eine Belichtungszeit von 4 

Sekunden und richteten das Teleskop dabei auf eine dem Fenster gegenüberliegende 

weitestgehend weiße Betonwand, da eine direkte Ausrichtung gen himmel nicht 

möglich war. 

Da einige Arbeitsschritte vorher der DADOS Spektrograph durch die Neon-Lampe 

geeicht wurde, erhielten wir bei den Aufnahmen weitestgehend gute Aufnahmen, in 

der Art wie Abbildung 17. 

 

Abbildung 17: Aufnahme SBIG bei diffusem Tageslicht 

Nun lädt man seine favorisierte Aufnahme in „Photoshop“ und schneidet das mittlere 

Spektrum der drei heraus. Über linke Leiste Auswahlrechteck-Werkzeug → Bereich 

markieren → Reiter „Bild“ → Freistellen. (Abb. 18) 

 

Abbildung 18: Ausschneiden des mittleren Spektrums 
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Dieses Spektrum speichert man zur späteren Bearbeitung als Photoshop Datei (.psd) 

und als Bild Datei (.jpeg) in maximaler Qualität. 

Jetzt ist es nötig die Datei in ein Format zu konvertieren, dass von Visual Spec (VSpec) 

gelesen werden kann. Dazu öffnen wir „Fitswork“, laden unser in „Photoshop“ 

gespeichertes Spektrum und speichern es als .fit Datei. 

Zur Benutzung von VSpec sei gesagt, dass die Benutzeroberfläche in Französisch-

Englisch vorliegt, da die Software von der französischen Astronomin Valérie Desnoux 

entwickelt worden ist, und daher viele Menüs oder Ausdrücke auf den ersten Blick 

unklar erscheinen. Daher gilt hier die Devise „Probieren geht über Studieren!“. Des 

Weiteren ist der „Speichern“-Button der beste Freund des Nutzers, da dieses 

Programms gerne und oft abstürzt. 

Visual Spec 

Nach dem Start von VSpec legt man sich über Options → Preferences → Reiter 

„Working Directory“ einen Arbeitsordner an, in dem sämtliche Profile und Bilder 

(automatisch) während des Arbeitsprozesses gespeichert werden.6 

 

Abbildung 19: Arbeitsordner in VSpec einrichten 

Das in „Photoshop“ bearbeitete Spektrum lädt man über File → Open Image in VSpec. 

Als Nächstes wählen wir einen Bereich aus, der die Grundlage des zu erzeugenden 

Spektrums bilden wird. Dazu klicken wir auf den Button „Display reference binning 

zone“(1). Dadurch können wir einen Bereich entlang der y-Achse auswählen und die 

Pixel dieser Auswahl in einer Spalte summieren. Durch diese Methode erreichen wir 

eine viel höhere Qualität des Spektrums, als sie mit einem einfachen Auszug der 

                                                           
6 Sollte das Programm auf Französisch vorliegen, kann unter Options → Préférences → Reiter „Language“ die 
Sprache auf Englisch gewechselt werden. 
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einzelnen Linien zu erreichen wäre. Für das „Binning“ bietet uns VSpec zwei 

Möglichkeiten (mit den Erläuterungen aus dem Online-„How-To“): 

Object Binning:   Alle Spektrallinien werden summiert. 

 

Reference Binning:  Die Untergruppe aller Spektrallinien wird summiert. 

Vorgeschlagene Option wenn man mit einer 

Kalibrierungslampe als spektrale Referenz arbeitet. (Diese 

Option habe ich daher auch gewählt.)(2) 

Beim Klick auf „Reference Binning“ erscheint ein weiteres Fenster mit einem 

vorläufigen Scan der weder kalibriert noch normiert ist. Allgemein versteht man unter 

Kalibrierung das Eichen eines Spektrums hinsichtlich der Zuordnung der Wellenlängen 

und der Intensität. Letzteres wird in VSpec als Normierung bezeichnet. Wie man gut 

erkennen kann, sind nach der Aufnahme des Spektrums einzelne Bereiche gestaucht 

oder gestreckt. Die Pixel müssen daher in ein Längenmaß umgerechnet werden, 

welches in der Astronomie üblicherweise die Einheit Nanometer, bzw. Ångström (1 Å 

= 0,1nm) ist. 

 

 

Abbildung 20: Scan des eingefügten Spektrums bei VSpec 
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Um in VSpec die Kalibrierung durchzuführen, klickt man auf den Button „Calibration 

Multiple Lines“ , woraufhin sich ein weiteres Fenster mit dem Titel „Non linear 

calibration“(1) öffnet. Bis zu diesem Punkt sollte man das ganze Projekt gespeichert 

haben, da insbesondere der kommende Teil sehr „empfindlich“ ist und wie bereits 

beschrieben, gerne abstürzt. 

Das Fenster zeigt eine Tabelle mit vier Spalten an, welche im Laufe des 

Arbeitsprozesses mit den Wellenlängen der einzelnen Peaks gefüllt werden soll. Um 

die Peaks richtig kalibrieren zu können, zieht man sich ein Referenzspektrum zu Hilfe. 

Empfehlenswert ist der Spektralatlas von Richard Wagner (siehe S.81 in [14]). 

Sollte man kein Referenzspektrum zur Hand haben, gibt es eine eingebaute Funktion 

in VSpec welche die Kalibrierung vereinfacht. Über Tools → Elements wird eine 

Übersicht aller Elemente und deren Wellenlänge angezeigt. Im Drop-down-Menü des 

Fensters kann man so z. B. Wasserstoff auswählen und bekommt darauf in der linken 

Ansicht die gängigen Wasserstoffkennlinien mit ihren Wellenlängen angezeigt. 

Um die einzelnen Peaks genauer in Augenschein zu nehmen, markiert man einen 

Bereich und klickt auf den Lupen-Button (2). Durch ein weiteres Markieren des 

gewünschten Bereiches wird ein kleines Textfeld (3) angezeigt in das die Wellenlänge 

eingetragen werden muss. Durch eine Bestätigung mit „Enter“, erscheint die 

Wellenlänge mit den zugehörigen Pixeln in der Tabelle (3). 

Abbildung 21: Wellenlängenkalibrierung mit VSpec 
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Je mehr Peaks man über den gesamten Scan kalibriert, desto genauer wird die 

Kalkulation bzw. desto mehr Spielraum hat man für Fehler die man dann aussortieren 

kann. Grundsätzlich reicht es jedoch, sechs bis zehn Peaks über den Scan verteilt zu 

kalibrieren. Hat man genügend Peaks kalibriert, wählt man unter „Degre“ einen 

Polynomgrad aus und klickt dann auf „Calcul“. Das Fenster ändert sich leicht und wird 

der Abbildung 22 ähneln. 

 

Abbildung 22: Kalkulation in VSpec 

In der vierten Spalte der Tabelle sind „d_Lambda“ Werte erschienen, die 

Abweichungen von der Kalibrierung kennzeichnen. Einzelne Werte die außerhalb von  

-0,8 < d_Lambda < 0,8 

liegen, sollte man markieren und durch „Entf“ löschen. Liegen jedoch zu viele 

abweichende Werte vor, muss man einen anderen Polynomgrad wählen oder die 

gesamte Kalibrierung wiederholen! In Abbildung 22 ist zu erkennen, dass der Wert 

einer Ca II Linie (3968.47) eine zu große Abweichung aufweist und ich diesen daher 

aus der Kalkulation entfernt habe. 

Ist die Wellenlängenkalibrierung abgeschlossen, zoomt man mit der Lupe auf einen 

möglichst geraden Bereich auf der x-Achse und klickt den Button „normalize“  (1). 

Wie genau diese Funktion berechnet ist auch unseren Dozenten ein Rätsel, da Frau 

Desnoux über seine Bedeutung Stillschweigen bewahrt. Jedoch wird beim Drücken 

die Intensität auf der y-Achse auf den Wert 1 gesetzt, was zur späteren Bearbeitung 

wichtig ist. Wenn man nun rechts am Fenster auf den Button „graduations“  (2) 

klickt, erscheint ein Koordinatensystem. 
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Erstellen eines normierten Scans 

Da bei meinem Scan die Instrumentenfunktion unbekannt ist, benötigt man ein 

„Pseudokontinuum“7.  

Über Radiometry → Compute Continuum färbt sich der ehemals blaue Scan orange 

und man erhält eine neue Leiste mit dem Button „point/courbe“  (1). Durch die 

Benutzung dieser Funktion kann der Nutzer Punkte entlang des Kontinuumsverlaufes 

setzen. Es empfiehlt sich möglichst viele Punkte zu setzen und die Peaks auszulassen. 

 

 

 

 

                                                           
7 Ein Kontinuum bezeichnet den ungefähren Scanverlauf ohne die Peaks zu berücksichtigen. 

Abbildung 23: Wellenlängenkalibriertes Spektrum 
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Sind alle Punkte gesetzt, führt man den Button „execute“  (1) aus. Zusätzlich zu 

dem erneuten Farbwechsel von orange nach blau erscheint ein Schieberegler, mit dem 

man den Verlauf des Kontinuums an den Scan anpassen kann. Jetzt zahlt es sich aus, 

wenn man viele Punkte gesetzt hat.  

Abbildung 25: Kontinuumserstellung mit VSpec 

Abbildung 24: Anpassung des Kontinuums 
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Wir wollen unseren wellenlängenkalibrierten Scan durch das erstellte Kontinuum 

dividieren. Damit dieser Schritt möglich ist, müssen wir zuvor das an den Scan 

angepasste Kontinuum alleine anzeigen lassen und umwandeln. Dazu sind folgende 

„Klicks“ von Nöten: erase graphics  → in der Drop-down-Leiste „Fit intensity“ 

wählen. Dann das umwandeln von orange in blau mit: Edit → Replace → Intensité. 

In Abbildung 26 ist meine Instrumentenfunktion zu sehen. 

 

Abbildung 26: Instrumentenfunktion 

Nun können wir die Division durchführen, um einen normierten Scan zu erhalten.  

Zusätzlich zu dem Kontinuum öffnen wir das Profil des wellenlängenkalibrierten Scans 

mit File → Open profile, markieren dieses und klicken nun auf Operations → Divide 

profile by a profile. Im darauf erscheinenden Fenster wählt man die beiden Profile aus 

und bestätigt mit „Ok“. 

Abbildung 27: Division der Profile in VSpec 
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Abbildung 28: Scan nach Division 

Auch hier muss man wieder die Grafik löschen, neu aufrufen und umwandeln über: 

erase graphics → in der Drop-down-Leiste „Fit intensity“ wählen. Dann das umwandeln 

von grün in blau mit: Edit → Replace → Intensité. 

Nun haben wir einen wellenlängenkalibrierten und normierten Scan. Zudem ist es uns 

möglich, mit VSpec ein farbiges Spektrum zu bilden, über: Tools → Synthesis (Man 

erhält ein s/w-Spektrum) → Synthese → Colorer (das Spektrum wird farbig). 

In Abbildung 29 kann man den endgültigen Scan mitsamt Spektrum sehen. Es ist auch 

gut zu erkennen, dass der Strich mit dem man den Wellenlängenbereich abgehen 

kann, mit dem im Spektrum übereinstimmt.8 Allerdings weißt dieser Scan noch 

Ungenauigkeiten links und rechts auf, die durch Rauschen entstanden sind. Zur 

endgültigen Bearbeitung in „Photoshop“ habe ich diese Bereiche herausgeschnitten 

und die letzten Schritte zum Bilden des Farbspektrums wiederholt. 

In „Photoshop“ werden nun als letzter Schritt im Bearbeitungsprozess wichtige Peaks 

mit ihren Elementen und deren Wellenlänge gekennzeichnet. Als Hilfestellung wurde 

der Spektralatlas von Walker erneut hinzugezogen. Über „Buntstift-Werkzeug“ → 

SHIFT + linke Maustaste erzeugt man die geraden Linien und über „Text-Werkzeug“ 

die Textfelder. 

 

                                                           
8 Es besteht eine leichte Verschiebung aufgrund der getrennten Fenster. 

Abbildung 29: "vorläufiges" Endspektrum in VSpec 
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3.4 Das bearbeitete, flusskalibrierte Spektrum 

Abbildung 30: Auswertung fertig bearbeitetes flusskalibriertes Spektrum 
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Wie in der Abbildung 30 zu sehen ist, wurde eine effektive Temperatur von 6300 Kelvin 

ermittelt. Zwar weicht dieser Wert um ca. 10% vom Literaturwert ab, aber nach 

Aussage der Dozenten sind diese 10% Abweichung bei der Sonnenspektroskopie 

immer wieder in den unterschiedlichen Sternspektroskopiekursen aufgetreten. 

Ich konnte durch diese erste eigene Spektroskopie tiefe Einblicke in die Aufnahme, 

Bearbeitung und Auswertung von Sternspektroskopien gewinnen und mir sowohl 

theoretisches als auch praktisches Wissen aneignen. Die Arbeit an dem „kleinen“ 

Teleskop im Seminarraum war so interessant, dass ich mir die Sternspektroskopie als 

Masterarbeitsthema als Option freihalten werde. 
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